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Exercicio1 3
SISTEMAS DE INFORMACAO
GEOGRAFICAE DADOS DE SATELITE

Objetivos
Este exercicio pretende ilustrar as potencialidades do programa ArcMap na

rN visualizacao e manipulacdo de dados de satélite.

Seréao explorados resultados obtidos por diferentes tipos de sensores instalados em
diferentes satélites.

Serao abordados os conceitos de banda, nimero de bandas, resolucao espacial, espec-
tral e radiométrica.

Serao também apresentados os processos de otimizacao que o ArcMap dispbe para
adicionar e visualizar dados de sensores/satélites especificos.

A. ABRIR E EXPLORAR DADQOS DE SATELITE

1. Abrir e explorar imagens de sensores 6ticos

1.1 Descarregar uma imagem Landsat 8 OLI/TIR

As imagens do programa Landsat s&o fornecidas em formato Geotiff, um formato

especifico das imagens TIFF (Tagged Image File Format) que contém informagao

do posicionamento da imagem.

a. Navegar para o endereco http://earthexplorer.usgs.gov/ e registar. No sepa-
rador Search Criteria escrever no endereco um local a escolha e clicar Show.
Em alternativa clicar sobre o mapa no local onde pretender fazer a busca de
imagens disponiveis, e.g. Lisboa. Ira aparecer Lisboa, Portugal. Clicar nesse
endereco (Figura 1, esquerda).
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b. Clicar no botdo Data Sets, abrir o separador Landsat Archive e selecionar a
opcao L8 OLI/TIRS (Figura 1, direita).

Search Criteria | [JEEERCd]| Additional Criteria || Results
2. Select Your Data Set(s)

Check the boxes for the data set(s) you want to search.
When done selecting data set(s), click the Additional
Criteria or Resulfs buttons below. Click the plus sign
next to the category name to show a list of data sets.

Use Data Set Prefilter (whats This?)

Data Set Search: |

BrCommercial
Bl Declassified Data
Gl Digital Elevation [

&I Digital Line Graphs
&1 Digital Maps L
HEOA
1 GEOGLAM
&I Global Fiducials
&l Global Forest Observations Initiative
Bl Global Land Survey
1 HCMM
1 JECAM Sites
EILIDAR
&I Land Cover
§ | SLandsat Archive [
« @[5 L8 OLVTIRS
| @[E] L8 OLUTIRS Pre-WRS-2
) @[] L7 ETM+ SLC-0ff (2003-present)
) @8] L7 ETM+ SLC-0n (1999-2003)
D@EL4s™
I@E L1-5Mss

GlLandsat COR L)

Figura 1 - Pagina inicial do sitio do EarthExplorer onde se faz a selegao do tipo de imagem e sensor disponivel.

c. Clicar no botao Results. Esta acao ira gerar uma pesquisa de todas as ima-
gens Landsat que incluem esta regido.

d. Descarregar uma imagem a escolha, de preferéncia uma que apresente
pouca cobertura nublosa. Nas opc¢des de download selecionar Level 1 Prod-
uct GeoTIFF Data Product, de forma a descarregar a imagem Landsat em
formato Geotiff com a corregcao geométrica (Level1 — para mais informagdes
sobre os diferentes niveis de correcao leia o ficheiro README). Guardar a
imagem numa pasta denominada Landsat / L8.

L Ll LandsatLook "Natural Color” Image (6.8 MB)

UL LGl LandsatLook "Thermal” Image (2.9 MB)

el LandsatLook "Quality” Image (446.2 KB)

DL Ll [ andsatlook images with Geographic Reference (10.2 MB)

DL LELE  Level 1 GeoTIFF Data Product (904.3 MB)

Download this Product

Level 1 Product Generation System (LPGS) apresentam os seguintes pardmetros
de processamento:
GeoTIFF como formato de saida;
Método de reamostragem: Cubic Convolution (CC);
Tamanho do pixel: 30 m (sensores TM, ETM+/0OLI) e 60 m (MSS) (bandas refletivas);
Projecdo: Universal Transverse Mercator (UTM); (projecdo Polar Stereographic para
cenas cujo centro apresenta latitudes maiores ou iguais a 63.0 graus)
Datum: World Geodetic System (WGS) 84;
Orientacdo da imagem com norte no topo.

e Mais informacGes em http://landsat.usgs.gov/Landsat_Processing Details.php
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Aimagem a descarregar tera aproximadamente 800Mb (depende da imagem
escolhida), pelo que devera demorar um pouco a carregar.
e. Descomprimir a pasta que acabou de descarregar.

1.1.1 Explorar a imagem Landsat8 no ArcMap

a. Abrir o ArcMap.
Explorar as diferentes bandas no Catalog. Através do browser do Catalog
navegar até a pasta onde guardou e descomprimiu a imagem, abrir a pasta
com a imagem Landsat8 que devera ter o nome LC8XXXXXXXXLGNOO.

c. Verificar qual o tipo de formatos raster presentes e as suas extensoes.

= £ LC82040332015145LGNOD
il LC22040332015145LGNOD_B1.TIF
@ LCa2040332015145LGNOD_B10.TIF
@ LCa2040332015145LGNO0_B11.TIF
il LC22040332015145LGNOD_B2.TIF
il LC22040332015145LGNO0_B3.TIF
@ LCa2040332015145LGN00_B4TIF
@ LCa2040332015145LGNO0_BS.TIF
il LC22040332015145LGNOD_B6.TIF
@ LCa2040332015145LGNO0_BT.TIF
@ LCa2040332015145LGNO0_BA.TIF
il LC22040332015145LGNO0_B9.TIF
@ LCA2040332015145LGNOD_BOATIF
4 LCB2040332015145LGNDO_MTL.bet

d. Quais os ficheiros que correspondem as bandas do sensor OLI e TIRS? Usar
a Tabela 1, no final deste documento, como auxiliar.

e. Adicionaras bandas 1, 2, 3,4,5,6,7, 8,9, 10 e 11 daimagem Landsat ao
Data Frame selecionando e arrastando os ficheiros. Explorar os niveis matri-
ciais que descarregou.

f. Identificar a resolugdo espacial, a resolugéo radiométrica, o sistema de co-
ordenadas de cada uma das bandas e comparar com os dados da Tabela 1.
Sobre cada um dos ficheiros, BLDR » Properties P separador Source.

g. O que significa Pixel Depth de 16 bits?

1.1.2 Funcionalidades do raster product [

O Arcmap apresenta uma forma mais rapida e facil de proceder a adicao de
raster datasets ao georreferencial usando a funcionalidade raster product @f@ .
Esta funcionalidade permite reconhecer automaticamente a informacgao con-
tida no ficheiro de metadados de determinados sensores, proporcionando a

individualizac&do de bandas por caracteristicas destes.
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No caso especifico das imagens do programa Landsat, o software reconhece
automaticamente este tipo de imagens e apresenta ja as combinagdes mais
utilizadas entre algumas das bandas', bem como a diferenciagéo entre ban-
das de diferentes caracteristicas.

a. No Catalog clicar 2 vezes sobre o raster product B . Verificar que esta fun-
cionalidade apresenta varios raster datasets diferentes.

= EE LC22040332015177LGNO0_MTL.bet
# Cirrus
B Cloud
#8 Landcover
3 Multispectral
## Panchromatic
@ pansharpen
# Snowlce
## Thermal
B Vegetation
3 Water

b. Adicionar o raster dataset Multispectral ao georreferencial. Abrir as proprie-
dades da camada e verificar que bandas estao representadas.
Properties » Symbology » Band (Figura 2). As restantes bandas do
sensor OLI estdo também presentes para representacao?

Layer Properties

General | Source | Key Metadata | Extent | Display | Symboledy | Functions

Draw raster as an RGB composite =)

Channel Band

el e | Red =
Green CoastalAerosol

Blue
[J alpha

Display Background Va ¥ Red
&8 Nearlnfrared

Blue

Green

ShortWavelnfrared_1
Stretch ShortWavelnfrared 2
Type: PercentClip  Cirrus

min: | 0.25 max: | 0.25 [Jinvert

[¥] Apply Gamma Stretch: 15614 | 1.56141 | 1.56141

Statistics
From Each Raster Dataset v

About symbology Red | Green | Blue v

S| [ Polem

Figura 2 - Propriedades da camada.

c. Adicionar o raster dataset Panchromatic ao georreferencial. Neste caso estao
representadas quantas bandas?

d. Adicionar o raster dataset Thermal ao georreferencial. Verificar que bandas
estdo representadas e as caracteristicas delas. As caracteristicas mantém-se
em relagcéo as bandas anteriormente adicionadas? Comparar com as carac-
teristicas apresentadas na Tabela 1.

e. Adicionar o raster dataset Pansharpen. Fazer zoom sobre uma zona especi-
fica. Verificar a resolugcao espacial e tentar interpretar a diferenga entre esta
camada e a camada Multispectral.

' A tematica relacionada com as combinagdes entre diferentes bandas encontra-se mais desenvolvida no exercicio 2.

SISTEMAS DE INFORMAGAO GEOGRAFICA: ANALISE DE DADOS DE SATELITE
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1.2 Descarregar e explorar uma imagem Landsat 7

a. No EarthExplorer descarregar a imagem Landsat 7 - Level 1, da ilha da Ma-
deira, de 28 de Margo de 2010. Guardar a imagem numa pasta denominada
Landsat/L7.

b. Abrir o raster dataset Multispectral desta imagem. Nota alguma diferenga
entre esta imagem e uma correspondente Landsat 8? A que se deve essa
diferenca?

c. Comparar a resolugao espacial, espectral e radiométrica destas imagens
com as da imagem Landsat 8. Ha diferencgas a registar? Em caso afirmativo
quais? Usar como auxilio as Tabelas 1 e 2 (no final deste documento).

d. Abrir o raster dataset Pansharpen. Usando a ferramenta Measure sau , esti-
mar o comprimento da praia da Ilha do Porto Santo.

1.3 Descarregar uma imagem MODIS AQUA.

Os conjuntos de dados nivel 2 e 3 (Level 2 e 3) do sensor MODIS a bordo do

satélite AQUA sao fornecidas no formato HDF. O HDF é um formato de arqui-

VO que permite armazenar estruturas de dados multiobjeto, tais como imagens

raster, matrizes multidimensionais ou tabelas binarias. Existem diferentes tipos

de modelos HDF, e o ArcGIS permite ler os formatos HDF4 e HDF5. Os ficheiros

HDF sao lidos pelo ArcGIS como rasters do tipo raster with subdatasets, mas

nem todos os arquivos HDF sao subdatasets. Este tipo de formato tem uma

estrutura de dados que permite multiplos conjuntos de dados (subdatasets) num
unico ficheiro. Cada um destes ficheiros pode corresponder a apenas uma banda
ou a multiplas bandas.

a. Navegar até ao endereco http://glovis.usgs.gov/. (Nota: O browser Chrome
apresenta alguns problemas na deteg¢ao da extensado Java que permite ace-
der ao catalogo de imagens, neste sentido aconselha-se o uso do Internet
Explorer).

b. No separador Collection escolher a opgdo MODIS Aqua» MYDO9A1 (MO-
DIS/Aqua Surface Reflectance 8-Day L3 Global 500m SIN Grid) que cor-
responde ao nivel 3 de refletancia diaria global. Na informagao geografica
colocar latitude 45.0 e longitude -7.1. Escolher a imagem da data 2014/03/06.
Descarregar a imagem fazendo Add » Send to Cart » Proceed To Chekout W
Submit Order (se pedido, fazer o registo com as credenciais fornecidas para
o EarthExplorer). Um endereco sera enviado para o e-mail de registo para
proceder ao download da imagem. Guardar a imagem numa pasta denomi-
nada de MODIS / L3.
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c. Consultar as carateristicas desta imagem em:
https://Ipdaac.usgs.gov/dataset_discovery/modis/modis_products_table/mo-
d09a1. Este produto apresenta, em cada pixel a melhor observacao possivel
L2G durante um periodo de 8 dias. Os produtos L2G apresentam valores de
refletancia espectral a superficie, tal como seria medida ao nivel do solo na
auséncia de dispersao atmosférica ou absorgao:

a. Quantas bandas esta imagem tem? Qual a resolugéo espacial?

e As caracteristicas dos produtos MODIS podem ser consultadas em:
https://lpdaac.usgs.gov/dataset_discovery/modis/modis_products_table.

d. Adicionar aimagem MODIS AQUA ao ArcMap usando o botdo Add Data <+ .
Como se trata de um raster with subdatasets, abrir a janela que permite
escolher os subdatasets. Escolher os 7 primeiros, que correspondem as 7
bandas previamente identificadas. Observar se existem diferengas entre a
informacao carregada e a consultada na pagina das caracteristicas das ima-
gens.

2. Descarregar, abrir e explorar imagens RADAR - SAR

2.1 Descarregar uma imagem do sensor ASAR a bordo do satélite Envisat
Envisat (Environmental Satellite) era um satélite de observagéo da Terra da
Agéncia Espacial Europeia (ESA) com 10 instrumentos a bordo, cuja missao teve
inicio em 2002 e terminou em 2012. O ArcGIS permite ler imagens de alguns
destes sensores, tal como imagens nivel 1 do sensor ASAR (Advanced Synthetic
Aperture Radar), algumas imagens do sensor MERIS (Medium Resolution Ima-
ging Spectrometer) e produtos AATSR (Advanced Along Track Scanning
Radiometer).

a. Navegar até: https://earth.esa.int/web/guest/data-access/sample-da-
ta/-/asset_publisher/tg8V/content/prestige-oil-spill-galicia-spain-
16237p_r_p 564233524 assetldentifie# 56 INSTANCE_z3vD_matmp

b. Em Available Sample Data escolher ASAR.

c. Descarregar a imagem ASAR Wide Swath (WS) ASA_WSM_1PXP-
DE20021117_104431_000000672011_00180_03741_0009.N1.gz, que cor-
responde ao dia 17-11-2002.

d. Descomprimir para uma pasta com o mesmo nome e adicionar a imagem
ASAR ao georreferencial do ArcMap.

a. Que regiao esta representada na imagem?
b. Qual a resolugéo espacial desta imagem? Compare com a resolucao
especificada nas caracteristicas do sensor (Tabela 3).

SISTEMAS DE INFORMAGAO GEOGRAFICA: ANALISE DE DADOS DE SATELITE
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3. Descarregar subprodutos de dados satélite

Para além das imagens de satélite disponiveis na internet para descarregar, existe
também muita informacao que é derivada, com maior ou menor processamento deste
tipo de dados. Um dos portais que disponibiliza alguma desta informagéo na tematica
MAR é o portal COPERNICUS MARINE ENVIRONMENT MONITORING SERVICE
(antigo MyOcean project). Neste portal, a informacéao raster vem fundamentalmente
no formato NetCDF.

3.1 Abrir e explorar dados em formato NetCDF

O NetCDF € um formato de arquivo projetado para suportar a criagdo, acesso e
partilha de dados cientificos, muito utilizado pelos geocientistas, que suporta N-di-
mensoes, i.e., X, Y, Z, tempo e outras dimensdes, assim como variaveis multiplas.

Ao contrario dos produtos raster, os ficheiros NetCDF nao sao adicionados ao

georreferencial através do botdo Add Data *  Em vez disso é necessario utili-

zar as ferramentas disponiveis na caixa de ferramentas Multidimension Tools.

No entanto é possivel arrastar um ficheiro NetCDF do Windows Explorer direta-

mente para a aplicagao.

a. Navegar até ao endereco http://marine.copernicus.eu/.

b. Fazer o registo, caso ainda nao esteja registado.

c. Selecionar a area de pesquisa dos produtos disponiveis clicando no separa-
dor IBERIA-BISCAY-IRELAND REGIONAL SEAS.

d. Selecionar o parametro Ocean Chlorophyll e nivel de Processamento L4-
OBS. Com estas opgdes devera surgir apenas um produto. Explorar o pro-
duto NORTH ATLANTIC CHLOROPHYLL (OPTIMAL INTERPOLATION) -
OCEANCOLOUR_ATL_CHL L4 NRT_OBSERVATIONS_009_037.

e. Clicar em MORE INFO para ver as caracteristicas do produto.

. Qual é a sua cobertura temporal?

g. Descarregar o produto. Fagca ADD TO CART e DOWNLOAD. Guardar numa
pasta designada MyOcean.

h. Explorar o produto no ArcMap. Adicione o ficheiro NetCDF usando a ferra-
menta Make NetCDF Raster Layer incluida no grupo de ferramentas (foolset)
Multidimension Tools. Use como variavel CHL e em Output Raster Layer defi-
na o nome “Clorofila”. Clicar ok.

i. Qual é a zona de Portugal que apresenta maior concentragao de clorofila?
Mudar a simbologia do tema para que as diferencas sejam mais percetiveis.

j-  Qual a zona, da total representada, que apresenta maiores concentracdes de
clorofila? Apresentar uma explicacao possivel para estas concentracoes.

SISTEMAS DE INFORMAGAO GEOGRAFICA: ANALISE DE DADOS DE SATELITE
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B. SISTEMATIZACAQ DE CONHECIMENTOQS

1. Que tipos de dados matriciais (raster) foram utilizados neste exercicio?

2. Enumerar os satélites e sensores cujas imagens foram utilizadas neste exer-

cicio.

3. Enumerar duas diferengas na resolugao entre as imagens Landsat 7 e
Landsat 8.
4. Definir resolucéo radiométrica.

5. Quantas bandas apresenta o sensor 6tico do Landsat 87?

Landsat 8 Bands Wavelength Resolution
Operational (micrometers) (meters)
Land Imager
(oL1) Band 1 - Coastal aerosol 0.43 - 0.45 30
Thir::inal Band 2 - Blue 0.45 - 0.51 30
Infrared Band 3 - Green 0.53 - 0.59 30
Sensor
(TIRS) Band 4 - Red 0.64 - 0.67 30
Launched Band 5 - Near Infrared (NIR) 0.85 - 0.88 30
February 11, 2013
Band 6 - SWIR 1 1.57 - 1.65 30
Band 7 - SWIR 2 2.11 - 2.29 30
Band 8 - Panchromatic 0.50 - 0.68 15
Band 9 - Cirrus 1.36 - 1.38 30
Band 10 - Thermal Infrared (TIRS) 1 10.60 - 11.19 100
Band 11 - Thermal Infrared (TIRS) 2 11.50 - 12.51 100
Tabela 1 - Bandas e respetivos comprimentos de onda das imagens Landsat 8
(retirado de http://landsat.usgs.gov/band_designations_landsat_satellites.php).
Enhanced Landsat Wavelength Resolution
Thematic 7 (micrometers) (meters)
Mapper
Plus Band 1 0.45-0.52 30
(ETM+)
Band 2 0.52-0.60 30
Band 3 0.63-0.69 30
Band 4 0.77-0.90 30
Band 5 1.55-1.75 30
Band & 10.40-12.50 &0 * (30)
Band 7 2.09-2.35 30
Band 8 .52-.90 15

Tabela 2 - Bandas e respetivos comprimentos de onda das imagens Landsat 7

(retirado de USGS, Landsat Missions e disponivel em: http:/landsat.usgs.gov/band_designations_landsat_satellites.php).
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| PRODUCT ID

| ASA_IMS_1P

[MAME

||A5ﬁ\R image single-look complex

DESCRIPTION

This is a single-look, complex, slant-range, digital image
generated from Level 0 ASAR data collected when the
instrument is in Image Mode (7 possible swaths HH or Vv
polarisation). It is primarily intended for use in SAR quality
assessment and calibration, and can be used to derive higher
level products.

[covERAGE

|[100 km along-track * 56- 100 km across-track

GEOMETRIC RESOLUTION

Approximately 6 azimuth, programmed chirp bandwidth
dependent slant range.

|Rﬁ\DIOMETRIC RESOLUTION

||l look in @zimuth, 1 look in range

PIXEL SPACING

Matural spacing in both Slant range and Azimuth. Azimuth
pixel spacing depends on Earth-Satellite relative velocity and
actual PRF.2. Slant range pixel spacing is given by ASAR
sampling frequency (19.208 MHz)

[s1ZE

[[741 Mbytes

Tabela 3 - Caracteristicas da imagem ASAR do tipo ASA_IMS_1P
(retirado de https://earth.esa.int/handbooks/asar/CNTR3-1-2.html

e https://earth.esa.int/handbooks/asar/CNTR2-6-2.html#eph.asar.prodalg.levb.prod.highorg.img.stalone.prodtypes.slook).
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Exercicio 1.1 3
SISTEMAS DE INFORMACAO
GEOGRAFICA E DADOS DE SATELITE

Objetivos
Este exercicio é a continuacdo do exercicio 1, onde se pretende mostrar

r N as caracteristicas das imagens dticas do satélite Sentinel 2.

O satélite Sentinel 2 transporta um inovador sensor 6tico de alta resolugao com 13 ban-
das espectrais e corresponde ao segundo satélite de uma familia de satélites, denomina-
da Sentinels, que entrou em 6rbita em 23 de Junho de 2015.

As imagens Sentinel 2 podem ser obtidas de forma gratuita a partir do Sentinels Scientific
Data Hub em https://scihub.copernicus.eu, mediante um simples registo prévio, e s&o
fornecidas ao utilizador no formato JPEG2000 (.JP2).

A.DESCARREGAR E EXPLORAR UMA IMAGEM SENTINEL 2

1. Descarregar a imagem ética Sentinel 2.
Pretende-se descarregar a imagem otica Sentinel 2 do dia 29-11-2015 da regido do
Algarve.
a. Navegar até ao Sentinels Scientific Data Hub usando o enderego
https://scihub.copernicus.eu.
b. Entrar no Scientific Hub.
c. Caso ainda nao tenha efectuado o seu registo no Sentinels Scientific Data
Hub, registar, caso ja esteja registado fazer Login.
d. Fazer zoom na regido do Algarve, como exemplificado na imagem da Figura
1 e com o rato desenhar um poligono de area de pesquisa.
e. Colocar a referéncia S2MSI1C como critério de procura, o que corresponde a
imagens Sentinel 2 nivel de processamento L1C.

SISTEMAS DE INFORMAGAO GEOGRAFICA: ANALISE DE DADOS DE SATELITE
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f. Usaroicone = acedendo as definigdes avangadas de procura (Advanced
Search) e no Sensing period pesquisar desde 28-11-2015 a 05-12-2015

usando o icone m .
g. Proceder ao download do produto que apareceu com estes critérios de
escolha usando o icone & (Download Product) e guardar a imagem numa

pasta denominada Sentinela2.

e A imagem a descarregar tem cerca de 6.3 Gb pelo que pode demorar
algum tempo a descarregar, consoante a ligagao da Internet.
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1.1 Abrir a imagem Sentinel 2 no ArcMap

Apoés descarregar a imagem é necessario descomprimir o ficheiro. As imagens
Sentinel 2 sao fornecidas ao utilizador no formato JPEG2000 (.JP2). Os produtos
sdo uma compilacao de granulos elementares de tamanho fixo, dentro de uma uni-
ca orbita. Um granulo é a partigdo minima indivisivel de um produto (que contém
as possiveis bandas espectrais). Para mais informagdes consultar
https://earth.esa.int/web/sentinel/user-guides/sentinel-2-msi/product-types.

Neste exercicio vamos abrir o granulo correspondente a zona T29SNB.

a. Dentro da pasta Sentinela2 navegar até a pasta GRANULE. Dentro desta
pasta, abrir a pasta S2A_OPER_MSI_L1C_TL_MTI__20151129T193058_
A002279 T29SNB NO02.00. Dentro desta nova pasta aceder a pasta IMG_
DATA. Esta pasta contém as 13 bandas em formato .JG2 que correspondem
as 13 bandas do sensor MSI do Sentinel 2.

b. Abrir estas 13 imagens, selecionando-as e arrastando-as para dentro do
ArcMap.

1.1.1 Explorar a imagem Sentinel 2 no ArcMap
a. Verificar a resolucéo espacial e radiométrica destas imagens.

B. SISTEMATIZACAQ DE CONHECIMENTOS

1. Identificar as principais diferengas entre as imagens do sensor OLI do
Landsat 8 e o sensor MSI do Sentinel 2, usando como suporte a Tabela1 e a
Figura 2.

Landsat 8 Bands Wavelength Resolution
Operational (micrometers) (meters)
Land Imager

(oLI) Band 1 - Coastal aerosol 0.43 - 0.45 30
and

Thermal Band 2 - Blue 0.45 - 0.51 30

Infrared Band 3 - Green 0.53- 0.59 30

Sensor
(TIRS) Band 4 - Red 0.64 - 0.67 20
Launched Band 5 - Near Infrared (NIR) 0.85 - 0.88 30
February 11, 2013
Band 6 - SWIR 1 1.57 - 1.65 30
Band 7 - SWIR 2 2.11 - 2.29 30
Band 8 - Panchromatic 0.50 - 0.68 15
Band 9 - Cirrus 1.36 - 1.38 30
Band 10 - Thermal Infrared (TIRS) 1 10.60 - 11.19 100
Band 11 - Thermal Infrared (TIRS) 2 11.50- 12.51 100

Tabela 1 - Bandas e respetivos comprimentos de onda das imagens Landsat 8
(retirado de http://landsat.usgs.gov/band_designations_landsat_satellites.php).
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10 metre spatial resolution:

10m

Band 4 (665 nm)

20 metre spatial resolution:

VNIR

Band & (740 nm)

60 metre spatial resolution:

NI

i

Band 9 (940 nm) Band 10 (1375 nm)

Figura 2 - Bandas e respetivos comprimentos de onda das imagens Sentinel 2
(retirado de ESA, Sentinel Online e disponivel em
https://earth.esa.int/web/sentinel/user-guides/sentinel-2-msi/resolutions/spatial).
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Exercicio 2
ANALISE DE IMAGEM EM AMBIENTE 51G

Objetivos
Este exercicio pretende introduzir a janela de Analise de Imagem (Image

Analysis), uma ferramenta disponivel no ArcMap que simplifica o processa-

mento de camadas (layers) ou temas matriciais (rasters ou imagens).

Sera dado destaque a visualizagao de imagens a partir da exploragao do painel Display.

Neste exercicio serao abordadas as operacdes de realce e composi¢oes coloridas, que
permitem realcar determinada informacao na imagem, apenas com operagoes simples e
utilizando a informacao de base das imagens.

A. ABRIR E EXPLORAR A JANELA IMAGE ANALYSIS

A janela de analise de imagem (Image Analysis) apresenta as ferramentas basicas para
processar € analisar imagens de satélite (Figura 1).

Esta ferramenta permite aplicar processos como operacgdes de realce, operacgdes al-
gebricas ou técnicas de fusdo. Os processos sao aplicados aos diversos tipos de dados
raster on the fly, i.e., os dados originais permanecem inalterados e os resultados de
processamento sao adicionados como camadas temporarias ao georreferencial (Data
Frame). Isto acontece porque estas ferramentas de processamento usam fungoes
(Functions). Para guardar o resultado de forma definitiva € necessario exportar os da-
dos.
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Figura 1 - Janela de Analise de Imagem.

1. Adicionar a janela Image Analysis ao ArcMap
a. Clicar no menu Windows P Image Analysis e acoplar a janela a um dos lados
da janela de aplicagdo do ArcMap.

A janela Image Analysis permite ter acesso as funcionalidades de processamento e
analise de imagem de que o ArcMap dispbe. Esta interface é composta por 5 elementos
principais: Layer List, Options e os painéis Display, Processing e Mensuration.

A Layer List permite ter acesso e visualizar todos os temas (layers) de natureza matricial
(raster) incluidos no georreferencial (Data Frame) e torna-los visiveis (ou ndo). O botao
Options permite configurar diferentes opgdes das ferramentas de processamento e
analise de imagem.

SISTEMAS DE INFORMAGAO GEOGRAFICA: ANALISE DE DADOS DE SATELITE
20



i i T TV L T M I T

-
IITIEgE HHEIFSiS I:l l -] Image Analysis Options ¥
j ; MDVI | Pan Sharpen | Orthorectify | Hillshade | Stretch | 04 | * :
* E Method: Gram-Schmidt v
‘%’USGS quads § | sensor Landsat 8 v
e 2008 MNAIP ai I:Il'IIIIIIIS Red-Band Weight: 0.42
@ ||:|| I t Green-Band Weight: 0.51 ;

EDDE CIR CLElerale Blue-Band Weight: 0.07
D @) LEII'IIjSEIt F!-EITIDI"'.E IR-Band Weight: 0 k
Use Wavelength J
Properties. .. o o |
< |
= = ...,..."' = ENEON T W TR

Figura 2 - Image Analysis

O painel Display permite aceder a ferramentas para melhorar a visualizagao dos dados.
O painel Processing apresenta um acesso facil a técnicas de processamento de imagem
mais frequentemente utilizadas, onde se inclui o recorte (clipping), ortorretificacao, filtros
de convolucao e construcdo de mosaicos.

2. Explorar as funcionalidades da janela Image Analysis

A lista de camadas (Layer list) representa todas as camadas raster disponiveis no geor-
referencial, incluindo as do tipo mosaic dataset, servicos de imagens e camadas WCS.
No entanto, uma camada do tipo raster catalog nao é visivel uma vez que n&o é reco-
nhecida nem utilizada nesta janela. Embora a lista de camadas n&o substitua a tabela
de conteudos, permite aceder igualmente a lista de propriedades de cada camada, bem
como remover camadas. Permite, adicionalmente, acelerar a visualizagao da camada
que, quando ativa, apresenta o icone &> .

2.1 Funcionalidades de visualizagao (display)

a.  Num novo projeto, adicionar o raster product Multispectral da imagem Landsat
8 - LC82040332015145LGNOO, disponivel na pasta Landsat8.

b. Centrar e fazer zoom a imagem na zona da desembocadura do Tejo. Utilizar
os botdes deslizantes de contraste (B, brilho ©*, transparéncia e gamma

Y , ajustar a imagem de forma a realga-la. Se clicar nos botdo em vez dos
botdes deslizantes o que acontece?

c. Uma vez restabelecidos todos os valores anteriormente editados e mantendo
0 zoom na imagem ativar a opgdo DRA (Dynamic Range Adjustment). Esta
opgao permite realcar a imagem usando apenas os dados contidos na exten-
sao do data view. Alterar o zoom da imagem e observar os resultados.

d. Visualizar a imagem completa clicando no botédo Full Extent @ . Ativar a
opg¢ao Background. O que acontece a imagem?
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0 Background selecionado define o valor de fundo a 0 (padrdo) e torna-o transparente
para a camada selecionada. O valor de fundo padrdo pode ser alterado nas propriedades

da camada, no separador Symbology, ou definido/alterado para qualquer camada adi-
cionada ao ArcMap em Customize ™ ArcMap Options ™ Raster » Raster Layer.

B. OPERACOES DE REALCE

As operacgdes de realce permitem melhorar a capacidade de interpretacdo visual de uma
imagem por um dos dois métodos: a) alteragdo de contraste da imagem e b) conversao
de tons de cinza para representacao de cores.

As operacgdes de realce permitem ajustar os dados contidos nas imagens, dados estes
que podem ser categorizados sob a forma de histogramas, com o objetivo de realgar
determinados atributos das imagens. Desta forma a visualizagdo e manipulagao do histo-
grama, carateristico de cada banda e/ou imagem, € a forma mais eficiente de proceder a
este destaque.

A ferramenta Interactive Stretch k abre a janela interativa que permite visualizar e mo-
dificar o intervalo maximo e minimo de valores (expansao do contraste) de visualizagao
de uma imagem. De uma forma muito simples, o software permite representar a imagem
numa gama de valores que tem a ver com a sua resolucao radiométrica real. Por exem-
plo, uma imagem de 8 bits tem 256 valores para representar a informagao nela contida,
mas nem sempre esses valores estdo efetivamente presentes na imagem, ou interessam
observar. A expanséo linear de contraste permite a visualizagdo numa gama de valores
definida pelo utilizador (definindo um valor minimo e um valor maximo) que é aplicada a
totalidade de valores de visualizagao (e.g. 256). Esta operagéao vai realgar determinada
informagao que de outra forma estaria distendida ao longo do histograma.

2.2 Aplicagao de diferentes tipos de realce

a. Desativar a opgao DRA, selecionar a opgédo Background e enquadrar a ex-
tenséo total da imagem.

b. Na janela Strecht (imediatamente a esquerda do botao h.) alternar entre as
diferentes opcdes None, Min-Max, Std-dev, Hist-eq, Percent clip e Esri. \erifi-
car e interpretar os diferentes resultados.

c. Clicar no botéo Interactive Stretch h. Definir manualmente os valores de
corte nos histogramas das bandas que representam a imagem, até ficar sa-
tisfeito com o resultado.
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c. Adicionar a banda 8 da imagem Landsat 8. Qual o valor minimo e maximo
que o Arcmap usa para representar a imagem?

d. Existe alguma diferenca nas janelas da ferramenta gy em relagéo as duas
imagens?

C. OPERACOES DE REALCE - COMPOSICAQ COLORIDA

3. Diferentes composig¢oes coloridas

O produto matricial Multispectral da imagem Landsat 8 corresponde a combinacéo colori-
da das bandas Vermelho-Verde-Azul, também denominada como RGB (do inglés Red-
Green-Blue). Esta composigao colorida € designada por cor verdadeira ou composi¢cao
RGB, pois corresponde ao posicionamento das bandas idéntico a forma como os nossos
olhos percecionam a cor. Qualquer alteragdo, quer na ordem quer na informagéo espec-
tral que compde a imagem, produz uma imagem que sera denominada de falsa cor.

O olho humano reconhece muitas mais cores do que diferentes tons de cinzento, desta
forma a variabilidade de cores pode ser utilizada para realgar pequenas diferencas entre
niveis de cinzentos. O processo que transforma uma imagem originalmente em niveis de
cinzento numa imagem em diferentes niveis de cor denomina-se por representagao em
pseudocor ou pseudocolor.

3.1 Composigao colorida cor verdadeira

a. Adicionar as bandas vermelho, verde e azul da imagem Landsat 8.

b. Proceder a composicao colorida em cor verdadeira: Selecionar, na lista de
camadas da janela de analise de imagem, as bandas correspondentes RGB
e clicar no botdo Composite Bands = . Ter em atengéo que a ordem de com-
posicao das bandas é dada pela ordem com que as bandas aparecem na
lista de camadas (de cima para baixo).

c. Compare a imagem criada com a imagem do produto matricial Multispectral.
Nota alguma diferenca? Em caso afirmativo tente justificar essa diferenca.

3.2 Composigao colorida em falsa cor

a. Adicionar as restantes bandas da gama infravermelho da imagem Landsat 8.

b. Proceder a composigéo colorida em falsa cor 5-4-3. A cor predominante-
mente vermelha corresponde a qué?

c. Proceder as composi¢des coloridas em falsa cor 6-5-4, 7-6-4, 7-5-3 em ima-
gens diferentes e observar as diferencgas.

d. Que combinagéo usaria para melhor visualizar a zona de praia emersa?
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3.3 Representagao em pseudocor

a.
b.
C.

Adicionar a banda 10 da imagem Landsat 8.
Nas propriedades da camada selecionar o separador Symbology.
Escolher um Color Ramp que permita representar os valores mais altos a
vermelho e os mais baixos a azul e faca ok.
Ampliar a regiao metropolitana de Lisboa e interpretar as diferencas. Dica:
usar como auxilio na interpretacdo a composigao colorida 5-4-3.
Gravar a informagao da rampa de cores num ficheiro .lyr:

1. Sobre a imagem e com BLDR selecionar Save As Layer File.

2. Gravar numa pasta a sua escolha com o nome PseudocorL8B10.

3.4 Espacializacao tridimensional de uma imagem em pseudocor

a.

Adicionar um Modelo Digital de Terreno (MDT) de Portugal continental usan-
do os recursos do Arcgis Online.

& -||[1:1 250 000 v B2 @
< Add Data... I
] ]

oo Add Basernap... |
HH Add Data From ArcGIS Online... | ——

Pesquisar por “Portugal MDT” e faca Add a Layer Package “Portugal MDT
30m (WGS84)”.

Delimitar o MDT em fungéo da extensao da imagem Landsat usando a ferra-
menta Extract by Mask.

Gravar o novo MDT com o0 nome MDT_Lx_L8 numa pasta a sua escolha.
Abrir o ArcScene usando o botdo @ .

Adicionar o ficheiro PseudocorL8B10.lyr" (gravado no ponto 3.3) e o MDT_
Lx_L8, manter apenas visivel a primeira imagem.

Nas propriedades da camada Landsat 8 (LC82040332015145LGNOO_B10.#),
selecionar o separador Base Heights e na opcéo Floating on a costume
surface escolher a superficie MDT_Lx_L8. Faca OK.

Nas propriedades da cena (BLDR sobre Scene Layers e de seguida em
Scene Properties), adicionar um fator de 10 no fator de conversao (Vertical
Exaggeration) para que as diferencas na elevagao sejam mais percetiveis.
Infirir a relagdo entre a temperatura e a altimetria do terreno.

' O ficheiro .lyr que adicionou contém a rampa de cores por si definida e gravada no ponto 3.3 e. Embora este ficheiro, em

si, ndo contenha os dados da imagem, ao adiciona-lo ao seu projeto (neste caso ao ArcScene) este adiciona, automatica-
mente, a imagem a partir da qual a rampa foi definida.
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D. SISTEMATIZACAO DE CONHECIMENTOS

1. Para que servem as operagoes de realce?

2. Qual a combinagao de bandas que corresponde a composicao colorida em
cor verdadeira nas imagens Landsat 8?

3. Qual a diferenga entre falsa cor e pseudocor?

Landsat 8 Bands Wavelength Resolution
Operational (micrometers) (meters)
Land Imager
(OoLI) Band 1 - Coastal aerosol 0.43 - 0.45 30
and
Thermal Band 2 - Blue 0.45 - 0.51 30
Infrared Band 3 - Green 0.53 - 0.59 30
Sensor
(TIRS) Band 4 - Red 0.64 - 0.67 30
Launched Band 5 - Near Infrared (NIR) 0.85 - 0.88 30
February 11, 2013
Band 6 - SWIR 1 1.57 - 1.65 30
Band 7 - SWIR 2 2.11 - 2.29 30
Band & - Panchromatic 0.50 - 0.68 15
Band 9 - Cirrus 1.36 - 1.38 30
Band 10 - Thermal Infrared (TIRS) 1 10.60 - 11.19 100
Band 11 - Thermal Infrared (TIRS) 2 11.50 - 12.51 100

Tabela 1 - Bandas e respetivos comprimentos de onda das imagens Landsat 8
(retirado de USGS, Landsat Missions disponivel em http://landsat.usgs.gov/band_designations_landsat_satellites.php).
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Exercicio 3 ,
CORRECOES GEOMETRICAS
DE IMAGENS OTICAS

@« Objectivos
— O objetivo deste exercicio é proceder a correcao geométrica de imagens.

A correcao geométrica € uma das operagdes incluidas no pré-processamento. Neste
exercicio ir-se-a corrigir a posicao geométrica, neste caso georreferenciar uma imagem
retirada da internet através de duas formas distintas: o posicionamento com pontos
homadlogos e o posicionamento com coordenadas conhecidas.

A. OBTENCAO DE INFORMACAQ

1. Obter a carta de sedimentos superficiais da plataforma continental portu-
guesa, disponivel numa publicagao cientifica do LNEG
(http://www.Ineg.pt/download/9638/24_2952 ART_CG14_ESPECIAL_Il.pdf).

1.1 Utilizar a ferramenta de corte do Windows (Snipping Tool &4 ) para
gravar uma imagem a partir do recorte da carta de sedimentos publicada.
Gravar duas imagens da mesma carta em formato JPG.

2. Abrir um novo projeto ArcMap.

3. Adicionar o servigo de mapas com a Carta Administrativa Oficial de Por-
tugal (CAOP) em WMS disponibilizado pelo IGEO (Dire¢ao Geral do Ter-
ritorio):

3.1 Navegar até ao sitio www.igeo.pt, va a dados abertos e pesquisar
“caop”. Carregar na opgao Servigos » Caop Continente » Continente
WMS e copiar o endereco disponibilizado.
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3.2 Carregar o servigo WMS para o seu projeto ArcMap. Através do Ca-
talog carregar em GIS Servers » ADD WMS Servers e colar o endereco
copiado no ponto anterior (Figura 1).

Catalog

Qo Wy @ E
Location: K3 Add WMS Server

=13

3 Folder Connections
Toolboxes
£ Database Servers

DEEHEE

EE] (IS Servers

| Add ArcGIS Server
5 Add ArcIMS Server

+

i

Add WCS Server

o+

5 My Hosted Services

[ Ready-To-Use Services

£3l Database Connections

g Add WIS Server

A Add WMTS Server
F CGC Servidor WMS on www.igeo.pt

£ Home - Documents\ArcGIS

Figura 1 - Adicionar servicos de mapas em WMS.

Add WMS Server (=50
URL: http:/fwww.igeo.pt/\WMS/CAOP/Continente? -
Examples: hittp:/fwww.myserver.com/arcgis/servicesmymap MapServer \MWMSServer?

http:/fuww.example. com/serviet/com. esri.wms.Esrimap?ServiceName =Name&
Version: Default version -
Server Layers
Get Layers
[=2 CAOP-Continente Name:
[=- CAOP-Continente WMs
~-UT2-CAOP2015_Regioes N
WVersion:
--UT3-CAOP2015 130
Mun_LIT2_UT3-CAOP2015
- NUTSI-2015 Abstract:
Servi?o de Visualiza??0 conforme o perfil
- NUTSII-2015
NUTSITI-2015 INSPIRE (ISO019128-WMS 1.3.0),
- enguadrado no Anexo I, Tema 4, Unidades
- Distritos-2015 Administrativas, Permite visualizar CAOP2015
~Concelhes-2015 - Continente. Limites Administrativos Oficais
Freguesias-2015 (NUTS1, NUTS2, NUTS3, Distrito, Munic?
= piofConcelho, Freguesia, ?reas
AreaAdmlnlsh’ah.vfa a0 ?5 Administrativas e Tro?os, UT2 Regizes, UT3 &
- Troco_AreaAdministrativa-2015 Munic?pio UT2 UT3) para o Continente, A
esta informa??o est? assodada a topon?mia,
bem come outra informa??o descritiva como
seja a ?rea ofidal de cada dreunsai??o
administrativa. Este servi?o cont?m a vers?o
da CAOP2015.
Account (Optional)
User:
Password: Save Password

3.3 Adicionar as camadas de dados disponibilizadas ao seu projeto Arc-
Map e manter visivel apenas os poligonos respeitantes aos Distritos.

3.4 Podera, se assim o entender, adicionar uma camada com imagens de
satélite para a area de visualizagao, por exemplo adicionando o Base Map
Imagery (File ™ Add Data » Add Base MapaW» Imagery). Notar, no entan-
to, que as corregdes geomeétricas a efetuar deverao referir-se, sempre, a

Carta Administrativa Oficial.

3.5 Verificar o sistema de coordenadas do projeto ArcMap, e (re)definir
o georreferencial com o sistema de coordenadas ETRS89-TMO06 (Datum
ETRS89 e projegcao Transversa de Mercator).

B. GEORREFERENCIACAO DE IMAGENS ATRAVES DE PONTOS

HOMOLOGOS

4. Adicionar ao seu projeto uma das imagens, com a carta de sedimentos,
gravada anteriormente.
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5. Ativar as ferramentas de georreferenciagcao do ArcMap (BLDR sobre a
barra cinzenta » Georeferencing).

Georeferencing = ICartaSedj JPG

6. Georreferenciar a imagem através de pontos homélogos, utilizando p. ex.
enseadas e promontérios reconheciveis no litoral:

6.1 Carregar em Georeferencing ™ Fit To Display, para colocar a ima-
gem na sua area de visualizagao.

6.2 Conectar varios pontos homoélogos (minimo 4) entre a sua imagem
e os elementos de referéncia do mapa, utilizando a opgado Add Control
Points. Deve-se carregar primeiro na imagem que quer referenciar e de
seguida na imagem de referéncia (Limites CAOP).

Utilizar a opcao de apagar e ativar a visualizagdo da imagem que se esta a geor-
referenciar para facilitar a localizagdo geografica dos pontos.

Georeferencing = ICartaSed_'I APG - I..c"+ .p::

Add Control Points

Select control points from the
source (ungeoreferenced) layer to

the referenced map coordinate
layer. To enter target coordinates
manually, select the point on the
source dataset first, then
right-click and select Input X and
¥" and enter the x and y target
locations into the dialog

Figura 2 - Caixa de ferramentas de apoio a georreferendiagéo

6.3 Verificar os pontos homologos conectados e o erro médio quadratico
(RMS Error) associado a georreferenciagao que esta a aplicar, carregan-
do em View Link Table [=] .

6.4 Explorar as diferentes transformacdes disponiveis. Aplique uma trans-
formagao afim e registe o erro quadratico médio desta operagao (Figura
3).
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Link O x

= e _|.|:+ Total RMS Error: Forward: 18,7223
Link ¥ Source ¥ Source ¥ Map ¥ Map Residual_x Residual_y Residual

1 458,940926 -616,804773 -110026,891721 -33505,555341 -3,0799 1,02663 3,2465

2 626,158356 -453,845309 -81821,480276 -6675,649250 -24,8003 8,26673 26,1418

3 717,5642580 -63,217112 -65994, 758466 57583,148591 2,78901 -0,92967 2,93988

4 595,472542 -517,268469 -80992,562419 -17128,406492 25,0912 -8,36374 26,4485
Auto Adjust Transformation: [ 1st Order Polynomial (Affine) hd

Degrees Minutes Seconds Forward Residual Unit : Unknown

Figura 3 - Erros quadraticos e diferentes transformacdes.

6.5 Fechar a caixa com a tabela de pontos de conexao e concretizar a
georreferenciagao carregando em Georeferencing » Update Georefe-
rencing.

Ao selecionar a opcéo Update Georeferencing esta a atualizar a corregdo geo-
métrica (georreferenciagéo) desta imagem gravando esta informagéo num fichei-
ro auxiliar. Se pretender podera reamostrar esta imagem, utilizando o sistema de
coordenadas de destino, em Georeferencing ™ Rectify.

7. Georreferenciar a imagem através de posicionamento de pontos em coor-
denadas conhecidas.

7.1 Adicionar a outra imagem gravada com a carta de sedimentos da pla-
taforma.

7.2 Tentar reconhecer as coordenadas e o sistema de coordenadas dos
pontos representados na Figura 4, utilizando o ficheiro .PDF original para
verificar esta informacgao.

7.2.1 O Mapa esta representado em coordenadas geograficas ou co-
ordenadas projetadas? Qual o sistema de coordenadas da representa-
cao?

SISTEMAS DE INFORMAGAO GEOGRAFICA: ANALISE DE DADOS DE SATELITE
30



SEDIMENTOS SUPERFICLALS

|
|
MORTUGAL ]
b oasameaw - °

A
FLATAPORMA CONTINENTAL

Figura 4 - Imagem com pontos cujas coordenadas foram reconhecidas da grelha de coordenadas da imagem.

Para proceder a georreferenciagao da imagem com pontos coordenados podera
optar por utilizar as coordenadas geograficas reconhecidas na graticula, e neste
caso devera redefinir o sistema de coordenadas do seu referencial para o siste-
ma de coordenadas respetivo, definindo ainda uma transformacao de coordena-
das apropriada.

Em alternativa, podera utilizar as mesmas posi¢des/pontos introduzindo as coor-
denadas transformadas para o sistema de coordenadas do seu georreferencial
de trabalho (neste caso o Sistema ETRS89-TMO06). Esta opgao permite ter uma
estimativa de erro de georreferenciacdo, em metros, que ndo acontece no caso
anterior por se tratar de coordenadas geograficas.

7.3 Iniciar a georreferenciagdo da nova imagem, através de pontos com
coordenadas conhecidas. Neste caso vamos optar pelas coordenadas
transformadas para o sistema de coordenadas projetadas do georreferen-
cial (Tabela 1).
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7.3.1 Carregar em +*, de seguida carregar sobre um dos pontos
marcados na imagem (Figura 4), depois com o BLDR faga Input XY e
introduzir as coordenadas respetivas (projetadas) (Tabela 1).

7.4 Repetir o procedimento anterior para os restantes pontos.

7.5 Verificar o RMS Error associado a ultima georreferenciacao efetuada.

8. Dizer qual o método de georreferenciagdo mais preciso. Porqué?

Coordenadas geograficas Coordenadas projetadas
(Elipsoide Internacional Datum Lisboa)' (ETRS89-TMO06)

PONTO 1 40°10'N -130743.78 56647.32

PONTOS

PONTO 2 9° 00’ W 40°10’N -73950.47 55879.57
PONTO 3 10°00° W 39°20°N -160966.22 -35522.57
PONTO 4 9° 00’ W 39°20°'N -74848.43 -36648.41

Tabela 1 - Coordenadas geograficas dos pontos reconhecidos na carta de sedimentos (representados na Figura 2).

" Definido no ArcMap por Datum Lisboa Hayford.
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Exercicio 4 ,
CORRECAO RADIOMETRICA

Objetivos

O objetivo deste exercicio é proceder a correcdo radiométrica de imagens
de satélite.

A correcao radiométrica € uma das operagdes que se incluem na fase de pré-processa-
mento. Neste exercicio ndo serao efetuadas operacdes de correcao atmosférica, apenas
serao convertidos os valores de niveis digitais (DN) para valores com significado fisico
(e.g. radiancia espectral e refletancia espectral).

A.INTRODUCAO

As correc¢des radiométricas principais correspondem a transformagao de niveis digitais
para valores de radiancia espectral e refletancia espectral e a operagdes de corregcao
atmosférica.

Uma vez que os dados de satélite sdo obtidos através de um sinal que atravessa a at-
mosfera, o valor registado num dado local (pixel) da imagem nao € um registo exato do
valor no terreno, pois a magnitude do sinal €, normalmente, alterada ao interagir com a
atmosfera.

A correcao atmosférica nem sempre é necessaria mas, em determinados casos, é acon-
selhada, como por exemplo:
1. No calculo de razbes entre duas bandas, uma vez que comprimentos de onda
mais pequenos experimentam maior scattering (disperséo) e vice-versa, envie-
sando assim os resultados;
2. Quando se pretende relacionar os niveis de radiancia da superficie com algum
fendmeno fisico;
3. Na comparacao de medi¢des realizadas em datas diferentes, onde condicdes
atmosféricas serdo geralmente diferentes.

SISTEMAS DE INFORMAGAO GEOGRAFICA: ANALISE DE DADOS DE SATELITE

34



B. CORRECAQ RADIOMETRICA DE IMAGENS OTICAS

1. Correcao radiométrica de imagens Landsat 8

As imagens Landsat sado disponibilizadas em numeros digitais (DN — Digital Number)
para os sensores OLI (Operational Land Imager) e TIRS (Thermal InfraRed Sensor),
podendo os valores ser recalculados de forma a obter: 1) radidncia espectral no topo
da atmosfera (L/1 ) e 2) refletancia espectral planetaria no topo da atmosfera ( pA ), e 3)
temperatura de brilho em Kelvin (K) ou graus Celsius (°C).

Os produtos Landsat 8 providenciados pela USGS EROS Center exibem informacdo em
nimeros digitais (DN) quantificados e calibrados, representando imagens multiespectrais
adquiridas pelos sensores a bordo do Landsat 8. Os produtos sdo fornecidos em formato de
numeros inteiros a 16 bits podendo ser redimensionados para refletancia espectral no topo
da atmosfera (TOA reflectance) ou radidncia espectral (spectral radiance), utilizando os

coeficientes fornecidos no ficheiro de metadados (ficheiro " MTL.txt"). Este ficheiro também
contém as constantes térmicas para converter as imagens térmicas TIRS para temperatura
de brilho. Informacao adicional pode ser consultada em:

http://landsat.usgs.gov/Landsat8_Using Product.php

a. Abrir num projeto ArcMap novo a imagem Landsat 8
LC82040332015145LGNOO (mesma imagem do exercicio 2).
b. Adicionar as bandas 1 a 11 da imagem Landsat 8 ao georreferencial.

1.1 Conversao de numeros digitais para radiancia espectral no topo da
atmosfera das bandas 10 e 11 (Infravermelho térmico)

A convers3o de DN para L N é feita através da expressao:
L.=M + A
A L g cal L

onde L/1 é a radiancia espectral no topo da atmosfera em (W / ( m? * sr * um)); M, éo
fator multiplicativo da radiancia parametrizado para cada banda
(RADIANCE_MULT_BAND_X, onde X € o numero da banda); O_ € o numero digital do
pixel e 4 Lé o fator aditivo parametrizado para cada banda (RADIANCE_ADD_BAND _X).
a. Abrir a ferramenta Raster Calculator.
b. Escrever expressao para a banda 10:
Float(RADIANCE_MULT_BAND_X*"LC8XXXXXXXXXXXXLGNOO_BX.TIF”)+(RADIANCE_ADD_BAND_X)
c. Gravar o resultado como Radiancia_B10, numa pasta designada por
Corr_Radiometrica.
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d. Anotar as diferengas nos valores entre a imagem original e a recém-criada,
principalmente no que respeita aos limites maximos e minimos.

e. Repetindo os passos anteriores, calcular a radiancia no topo da atmosfera
para a banda 11, usando os parametros respetivos no ficheiro de metadados

1.2 Converséo de numeros digitais para refletdncia espectral no topo da
atmosfera das bandas multiespectrais 1 a 8

A conversao de numeros digitais para refletancia espectral no topo da atmosfera
€ realizada pela expressao:

P) :Mchal+Ap

onde p/l'é a refletancia espectral planetaria no topo da atmosfera, sem a corre-
¢ao do angulo solar; M é o fator multiplicativo da refletancia parametrizado para
cada banda (REFLECTANCE_MULT _BAND X, onde X é o numero da respetiva
banda);

0., € o numero digital do pixel e 4 ¢ o fator aditivo parametrizado
(REFLECTANCE_ADD BAND_X) para cada banda.

A refletancia no topo da atmosfera corrigida do angulo solar é dada por:
! !/
P} P}

cos (0,) sin 0,.)

P,

onde P, é a refletancia planetaria, 6, é o angulo de elevagéo solar local (o an-
gulo de elevacgao solar central da imagem, em graus, é fornecido no ficheiro de
metadados - SUN_ELEVATION) e 6., € o angulo zenital solar local, sendo calcu-
lado pela expresséo 0., = 90°- 0.,
Desta forma a expressao final de conversao dos niveis digitais para refletancia
no topo da atmosfera é:
M + A4
p Q0 cal “p

Po— sin (0,)

(Ver nota do ponto h.)

a. Abrir o ModelBuilder EP“ , uma aplicagdo que permite automatizar procedi-
mentos no ArcGis.
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A semelhancga do ja realizado anteriormente, ira usar o Raster Calculator
para proceder a conversao dos niveis digitais, mas agora de forma automa-
tizada. No Search pesquisar por Raster Calculator. Arrastar esta ferramenta
para a janela do modelo (Model).
Criar uma variavel do tipo Double com 0 nome Mp:

1. Sobre o espago vazio do modelo e com o BDLR P Create Variable ™

Double.

2. Sobre a variavel Double criada e com o BDLR » Rename » Mp.
Criar duas variaveis do tipo Double com o nome Ap e outra com o nome SE,
usando o mesmo procedimento anterior.
Colocar todas as variaveis como parametros do modelo: sobre cada uma das
variaveis carregar com BLDR P Model Parameter. Quando a variavel esta
definida como parametro do modelo aparece um P no canto superior direito
da mesma.
Definir os valores de cada uma das variaveis para a banda 1 usando a
informacao contida no ficheiro de metadados “#_MTL.txt”: com duplo clique
sobre cada variavel podera preencher o valor correspondente. Esta instrucéo
fara aparecer a variavel a cores, o que indica que esta pronta a ser utilizada.
Clicar duas vezes sobre a ferramenta Raster Calculator no modelo que abre
as propriedades da ferramenta e permite o preenchimento dos campos com
a informacéo necessaria.
Definir a expressao acima para converter os valores em niveis digitais para
refletancia no topo da atmosfera para a banda 1. Usar as variaveis e cama-
das ja existentes na ferramenta, bem como as expressoes que esta apresen-
ta. Gravar o resultado na pasta refletdncia com o nome RTOAB1 e clicar OK.

Notar que no ArcMap os argumentos das fun¢oes trigonométricas sao em
radianos pelo que tera que multiplicar o angulo em graus por /180 para
converter para radianos.

Definir a variavel banda 1 (LC...._B1.TIF) e o resultado (RTOAB1) como
parametros do modelo. O aspeto final do modelo devera ser semelhante a:
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e ModeloEx4 = B

Model Edit Insert View Windows Help
e +BEx 2@ daf ks v >
p ~

d.\
Raster
Calculator (2)

j. Correr o modelo carregando no botéo I .

k. Salvar o modelo com o nome ModelEx4 na toolbox ToolSOPHIA (caso esta
toolbox nao exista devera cria-la com o botdo &y )

. Adicionar a ferramenta criada ao ArcToolbox: BLDR » Add Toolbox.

m. Usar o modelo criado para converter as restantes bandas dando um nome
apropriado ao resultado do processamento.

1.3 Converséao de radiancia no topo da atmosfera para temperatura de
brilho

As imagens térmicas fornecidas pelo sensor TIRS (Thermal InfraRed Sensor)
podem ser convertidas de radiancia espectral no topo da atmosfera para tempe-
ratura de brilho expressa em graus Kelvin e em graus Celsius. A temperatura de
brilho no sensor (também denominada de temperatura radiante - 7 ) assume
que a Terra € um corpo negro’, i.e., com emissividade igual a 1, e inclui os efeitos
atmosféricos (como a absor¢ao) e outras emissdes ao longo do caminho percor-
rido entre superficie-sensor. A temperatura de brilho no sensor em graus Kelvin
pode ser estimada pela expressao:

K
T pu—

rad In ( +1)

' Corpo que absorve toda a radiagdo incidente.
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onde 7 _, € atemperatura de brilho no sensor em graus Kelvin, KI € a constante
térmica especifica de cada banda de infravermelho térmico (Bandas 10 e 11) e
€ designada por K1_CONSTANT_BAND_X no ficheiro de metadados, K2 éa
segunda constante térmica especifica de cada banda uma destas bandas e é
designada por K2 CONSTANT_BAND Xe L
atmosferaem W/ (m? * sr * um).

1 € a radiancia espectral no topo da

A temperatura de brilho em graus Celsius € dada pela expressao:

T =T -273.15
rad (° C) rad
a. Converter as bandas térmicas (ja previamente convertidas em radiancia
espectral no topo da atmosfera no ponto 1.1) para temperatura e brilho em
graus Kelvin e Celsius usando as expressdes acima descritas.

1. 4 Representacgao grafica da variagao da temperatura na regido de Lis-

boa

a. Escolher, e visualizar, uma das bandas térmicas corrigida para temperatura
de brilho em graus Celsius.

b. Fazer zoom a imagem para a regiao de Peniche.

c. Adicionar a ferramenta 3DAnalyst a barra de ferramentas, se esta ainda ndo
se encontrar adicionada: Customize» Toolbars » 3DAnalyst.

3D Analyst ~ | [© tcb10 ~| 9B &

T

d. Como camada de analise (3DAnalyst Layer) selecionar a banda térmica
escolhida.

e. Com o botao E tracar um segmento de reta, da esquerda para direita, des-
de as Berlengas até um pouco além do vale do Tejo.

f. Projetar o perfil da temperatura de brilho ao longo do segmento tragado atra-

vés do botao Eb T, analisar o resultado.

1. 5 Comparacéao da informacgao espectral tedrica com a informacgao das
imagens
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A USGS tem uma série de ferramentas e servigos de apoio a quem trabalha com
as imagens por eles disponibilizadas. Destes servicos destaca-se o Spectral
Viewer, uma ferramenta que permite determinar as melhores bandas de uma
imagem para interpretar ou estudar determinada propriedade do terreno.

Esta ferramenta permite a visualizagdo de como as bandas de diferentes satéli-
tes registam a intensidade do comprimento de onda (cor) da luz, denominado de
Resposta Espectral Relativa. O Spectral Viewer dispde de informagao para varios
satélites como o Landsat 8 e para varios materiais, como a agua ou a vegetacao.

Esta ferramenta é usada em modo online e esta disponivel em
http://landsat.usgs.gov/tools_spectralViewer.php.

1.5.1 Comparar a informacéao espectral tedrica da refletancia da agua
e a respetiva informacao exibida pela banda 4

a. Trace um perfil sobre a agua (numa zona onde a agua esteja limpida) na
imagem da refletancia no topo da atmosfera da banda 4.

b. Compare-o com o perfil exibido pela ferramenta Spectral Viewer.

c. Trace novo perfil sobre outra zona onde a agua apresente sedimento em
suspensao. Indique as diferencas.

1.5.2 Comparar a informacéao espectral da vegetacao

a. Compare a informacgéao espectral da vegetacao do tipo Fir Spruce com a ve-
getacao do parque de Monsanto em Lisboa.

b. Experimente outros tipos de vegetagao.
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Exercicio5
PLUMAS TURBIDAS

Objetivos

O objetivo deste exercicio é detetar plumas tirbidas utilizando operacoes

algébricas entre bandas.

A.INTRODUCAO

Os rios e estuarios ligam os ecossistemas terrestres aos oceanicos, proporcionando
zonas de mistura entre aguas fluviais, costeiras e abertas. Estas areas de interface sao
ricas em nutrientes, compostos organicos muito importantes para a produg¢ao primaria

e heterotrdfica nas zonas costeiras. Permitem a entrada de sedimentos terrestres, em
suspensao, através das transferéncias para o oceano. Processos que ocorrem junto a
costa como a producédo primaria, a atividade microbiana e a produgédo secundaria séo
afetados por este importe de nutrientes terrestres. Uma vez que a carga de sedimentos
terrestres em suspensao pode desempenhar um papel importante no ciclo de nutrientes,
importa conhecer a dindmica destas zonas de mistura designadas por plumas turbidas
(Figura 1). As plumas turbidas podem ser caracterizadas pela concentragdo de sedimen-
tos em suspensdo, matéria organica, nutrientes e contaminantes transportados a partir
de regides vizinhas.

As plumas turbidas podem ser distinguidas usando diferentes assinaturas espectrais nos
ambientes aquaticos. Os coeficientes de absorgao total sdo mais afetados pela concen-
tracdo de sedimento em suspensédo do que pela concentracao de clorofila ou matéria
organica dissolvida.

Figura 1 - Imagem com plumas turbidas junto a costa.
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B. OPERACOES ALGEBRICAS

1. Detecao de plumas turbidas em imagens o6ticas de alta resolugao

1.1 Descarregar e corrigir os niveis radiométricos de uma imagem otica da
regido autonoma da Madeira.

a.

Descarregar, do site EarthExplorer, e visualize a imagem L8 de 10 de janeiro
de 2014 da regido autobnoma da Madeira.
Fazer a corregao radiométrica das imagens para radiancia espectral no topo

da atmosfera (radiancia TOA - L__ ) usando a toolbox SR — Landsat 8 dis-

704
ponibilizada em http://www.mundogeomatica.com.br/LivioSR102.htm.

1. Descarregar a ferramenta e guardar numa pasta a escolha.
2. Adicionar a ferramenta ao ArcToolbox.
3. Correr o modelo 2 - RADIANCIA ESPECTRAL NO TOPO DA AT-
MOSFERA, com os valores do ficheiro de metadados e grave as imagens
numa pasta denominada CorrRad.

Corrigir os valores de L, para p,,, da banda 4 da imagem Landsat 8. A cor-

recao para valores de refletdncia TOA (p_, ) € realizada segundo a expressao:

TOA)
* * 2
7 L o d

P 104~ FO « sin ‘95E

onde d é a distancia Terra-Sol em unidades astronémicas - EARTH_SUN _
DISTANCE, 6, é o angulo de elevagéo solar local - SUN_ELEVATION (va-
lores presentes no ficheiro #MTL.txt) e FO é a irradiancia solar média de cada
banda, que no caso da banda 4 corresponde a 1549.4 (Vanhellemont and
Ruddick, 2014).
1. Calcular a primeira constante do numerador da fragéo (7 . d°).
2. Calcular a constante do denominador da fragdo (F0 . sin 0,) para a
banda 4.
3. Usando a funcéo Band Arithmetic Function — acedida com o botdo £
e sobre o raster da banda 4, BDLR pInsert pBand Arithmetic Function.
4. Colocar User Defined em Method e preencher com a expressao de
conversao para refletdncia usando as constantes calculadas acima, clicar
ok duas vezes.

5. Renomear a imagem criada como RefB4.

1. 2 Criar mascaras de area de interesse e terra
A criacao de mascaras ira fazer uso de dados vetoriais de apoio que podem ser

descarregados da internet.
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a. Aceder ao site da DGT com o enderego: http://www.dgterritorio.pt/ e pesqui-
sar Madeira concelhos.

b. Aceder a CAOP2015 (Carta Administrativa de Portugal) e navegar até CAOP
(download).

c. Clicar em Carta Administrativa Oficial de Portugal - Versao 2015, e faca o

download dos poligonos da Area administrativa da Madeira.
d. Descomprimir e adicionar o tema descarregado ao georreferencial.

A regiao de analise das plumas turbidas sera a costa sul da ilha da Madeira, pelo que se
ira necessitar de uma mascara da ilha. Para efetuar este procedimento é aconselhavel
simplificar a informacgéo vetorial (utilizar a instrugdo Dissolve usando um campo comum
a todos os elementos para remover as fronteiras internas).

Uma vez dispondo de um poligono unico para a regido que queremos mascarar € pos-
sivel aplicar essa mascara aos ficheiros do tipo raster. Em primeiro lugar ira delimitar a
zona de interesse e de seguida, sobre esta, proceder a mascara (remog¢ao) dos valores
de terra.

e. Selecionar a area de interesse na imagem RefB4:
1. Usando a fungéo Clip Function — acedida com o botédo /£ e sobre o
raster BDLR » Insert » Clip Function.
2. Usar como Type a opgao Outside.
3. Como Clipping geometry usar o tema Madeira.
4. Fazer Ok em ambas as janelas.
f. Proceder a mascara dos valores de terra.
1. Usar a fungéo anterior sobre a imagem criada no ponto anterior.
2. Usar como Type a opgéao Inside, uma vez que se pretende remover a
area dentro do poligono de mascara.
3. Como Clipping geometry usar a camada Madeira.
4. Selecionar a opgao Use Input Features for Clipping Geometry, para
que a mascara apresente os contornos do poligono.

5. Fazer Ok em ambas as janelas.
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Os processos aplicados anteriormente usando as fungdes da ferramenta Analise de Ima-
gem séao todos aplicados on-the-fly, i.e. os dados originais permanecem inalterados e os
resultados decorrentes sao adicionados ao georreferencial como camadas temporarias.
Para a utilizagao futura destes dados, estes deverao ser gravados (exportados).

g. Exportar a imagem resultante da ultima mascara como Ref_mask_B4.

1.3 Calcular a concentracao de particulas em suspensao
O calculo simplificado da concentracao de particulas em suspensao (CPS) pode
ser realizado usando a banda 4 a partir da expressao:

CPS = Ap},

onde 4 = 289.29 gm ~ (ver - Vanhellemont and Ruddick, 2014).
a. Calcular a concentracao de particulas em suspensao (CPS) segundo a ex-
pressao acima:
1. Usando a camada Ref_mask_B4 e a funcio Band Arithmetic
Function calcular a CPS.
2. Renomear, e exportar, a camada para CPS.
b. Representar os valores de CPS numa imagem em pseudocor e excluir os
valores negativos e os valores superiores a 50:
1. Propriedades da camada P> Symbology W Classified » Classify » Ex-
clusion > valores negativos e valores superiores a 50.
2. Clicar ok.
3. Representar os valores numa escala colorida.
4. Clicar ok.

1.4 Criacao de um mapa tematico de concentracao de particulas em
suspensao

A criacao de mapas tematicos das propriedades estimadas usando imagens de
satélite € muitas vezes o objetivo final da detegdo remota.
a. Usando a camada CPS proceder a criagdo de um mapa tematico a seme-
Ihanca da Figura 2.
1. Ir para o Layout View carregando no botdo [ , disponivel no canto
inferior esquerdo do Data View.
2. Posicionar a costa sul da ilha da Madeira no centro do Data Frame.
3. Adicionar uma escala grafica, indicagdo de norte e uma legenda.
4. Representar a ilha da Madeira usando a imagem Pansharpen
disponibilizada pela USGS.
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Figura 2 - Mapa tematico da concentracéo de particulas em suspenséo (CPS) na costa sul da ilha da Madeira.

Referéncias:
Vanhellemont, Q. and Ruddick, K., 2014, Turbid wakes associated with offshore
wind turbines observed with Landsat8, Remote Sensing of Environment, 145:105-

155. DOI: 10.1016/j.rse.2014.01.009
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Exercicio 6.1
MAPEAMENTO DE FUNDOS MARINHQOS

Objetivos
O objetivo deste exercicio é proceder ao mapeamento de fundos marinhos
usando dados de dete¢do remota do fundo do mar, nomeadamente dados de

sondadores acusticos e imagens dticas, usando classificacdo automatica.

A.INTRODUCAO - DADOS BACKSCATTER

Existe um conjunto de técnicas geofisicas, sedimentologicas e biolégicas que podem ser
utilizadas para obter informacao sobre os fundos oceanicos.

De entre os equipamentos de geofisica, os sondadores acusticos, como o sonar de varri-
mento lateral e os sondadores multifeixe, destacam-se pelo potencial que apresentam na
identificacao de diferentes tipos de sedimentos superficiais e na construgdao de modelos
digitais de terreno que reproduzem o relevo submarino. Esta informacao, aliada a colhei-
ta de amostras no fundo, permite cartografar as suas carateristicas.

Os sondadores acusticos funcionam através da medicao da intensidade do retorno do
sinal acustico (backscatter) a partir do fundo do mar, sendo esta intensidade fungao
das propriedades dos sedimentos na sua superficie e da propria rugosidade do fundo
(material refletor). De uma forma geral, um retorno forte — tons claros - esta associado a
presenca de rocha e/ou sedimentos grosseiros; um retorno fraco — tons cinza escuros -
esta associado a sedimentos mais finos.

Uma vez que a propria rugosidade do material, ja incorporada na associacao rocha/
sedimentos finos, ira afetar a refletividade do solo, micro tipografias tais como ripples, e
a bioturbagao, podem também ser cartografadas, pois apresentam um retorno do sinal
intensificado.
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B. MAPEAMENTO FUNDOS MARINHOS - CLASSIFICACAQ
AUTOMATICA

1. Imagens backscatter de sonar de varrimento lateral

A imagem da intensidade do retorno do sinal acustico (backscatter) utilizada neste exer-
cicio, obtida a partir de sonar de varrimento lateral, foi gentilmente cedida pela Divisao
de Geologia Marinha — Secc¢ao de Geofisica, do Instituto Hidrografico
(http://www.hidrografico.pt/geologia-marinha.php) (IH, 2015).

1.1 Classificagao automatica de uma imagem

a. Abrir aimagem backscatter adquirida com o sonar de varrimento lateral, que
se encontra na pasta denominada DadosEx6\Backscatter, no ArcMap.

b. Localizar a area onde foi realizado o levantamento de sonar de varrimento
lateral.

c. Indicar a resolugao espacial do levantamento.
Identificar, visualmente, areas de rocha/sedimento grosseiro e sedimentos
finos, baseado nos valores de intensidade presentes na imagem e tendo em
conta a introducao acima descrita.

e. Abrir a barra de ferramentas Image Classification (BLDR sobre o friso supe-
rior e ativar Imagem Classification).

Image Classification

Classification = I@ sonard ;l ] ~ K

f. Classificar o tema Sonar usando a classificacdo automatica, nao assistida,
Iso Cluster Unsupervised Classification com diferente nimero de class-
es. Experimentar classificar as imagens com 3, 4, 5, 10 e 20 classes. Mudar
a simbologia da classificacao — experimentar dar a mesma tonalidade as
classes que considerar pertencerem ao mesmo tipo de fundo. Observar o
resultado.

g. Observar as diferengas entre as classificagdes anteriores e escolher a que
obteve melhores resultados, justificando a sua escolha. Gravar essa opg¢ao e
apagar as restantes.

SISTEMAS DE INFORMAGAO GEOGRAFICA: ANALISE DE DADOS DE SATELITE
49



Exercicio 6.2
MAPEAMENTO DE FUNDOS MARINHQOS

Objetivos
O objetivo deste exercicio é proceder ao mapeamento de fundos marinhos
usando dados de dete¢do remota do fundo do mar, nomeadamente uma ima-

gem de satélite adquirida por um sensor 6tico, em conjunto com operagdo de
vizinhanca do tipo classificagdo automatica.

A.INTRODUCAO - DADOS OTICOS

Nas zonas costeiras pouco profundas e com aguas limpidas, a radiagédo solar consegue
penetrar na coluna de agua e atingir o substrato. Se o substrato for uniforme é possivel
estimar a profundidade da coluna de agua, uma vez que a diferentes profundidades cor-
responderao diferentes intensidades do sinal. Se, por outro lado, o substrato for diferen-
ciado é possivel mapear essas diferencas.

A segunda parte deste exercicio consiste em estimar a profundidade relativa da coluna
de agua, na regiao do banco do Cambalhao (junto a peninsula de Troia), assumindo
que a agua nesta zona é limpida e o substrato & uniforme (corresponde a sedimento na
classe das areias). A profundidade da coluna de agua pode ser classificada em 4 domi-
nios principais: Supratidal, Intertidal, Subtidal pouco profundo e Subtidal profundo. A
imagem a classificar € uma imagem oética Landsat 8, recortada para a area de interesse.
O nivel da maré no momento de aquisi¢céo desta imagem era -0.8m NMM' (Figura 1).

Figura 1 - Imagem Landsat 8, recortada para a area de interesse o banco do Cambalh&o.

" NMM - Nivel Médio do Mar
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B. MAPEAMENTO FUNDOS MARINHOS - CLASSIFICACAQ

ASSISTIDA

1. Imagens éticas do sensor Landsat 8

1.1 Classificagao assistida da imagem ética

Num novo projeto Arcmap:

a. Adicionar a imagem compésita L8130908, presente na pasta DadosEx6\
Landsat8, ao georreferencial.

b. Adicionar o tema vetorial Terra_Mask, presente na mesma pasta.

1.1.1 Selecionar a area de interesse — zonas humidas e area marinha
a. Eliminar as zonas de terra usando o tema vetorial Terra_Mask:
1. Usando a fungao Clip Function — acedida com o botao £ e sobre o
raster BDLR P Insert » Clip Function.
2. Usar como Type a opgao Inside.
3. Como Clipping geometry usar a camada Terra_Mask.
4. Selecionar a opgao Use Input Features for Clipping Geometry, para

que a mascara apresente os contornos do poligono.

5. Fazer Ok em ambas as janelas.

6. Renomear o tema para L8130908_Mask. Ter em atencéo que este tema
€ provisorio uma vez que resulta de uma operagao com uma funcao da
ferramenta Analise de Imagem. Gravar o tema para o tornar permanente.

1.1.2 Definigdo das areas de treino

Neste exercicio pretendesse-se proceder a classificacao assistida (ou super-
visionada) pelo método da maxima verosimilhanga. Esta opgao é também
suportada pelo ArcMap e encontra-se igualmente disponivel na barra de
ferramentas Image Classification. Para a classificacao assistida necessita
de um ficheiro com as assinaturas das areas de treino que sao definidas pelo
utilizador. O primeiro passo de qualquer classificacdo assistida sera, neces-
sariamente, definir as classes onde treinar o classificador. As classes usadas

neste exercicio sao:

Supratidal — corresponde a zonas de praia emersa — areia seca.
Intertidal — corresponde a zonas sob influéncia da maré.

Subtidal pouco profundo — corresponde a zonas pouco profundas.
Subtidal profundo — zonas profundas.

Raso — zona interna do estuario sujeita a acdo da maré.

Sapal — zona interna do estuario sujeita a agdo da maré mas com
vegetacao.
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a. Selecionar a imagem a classificar na barra Image Classification.

b. Definir as areas de treino com o botso I ~ usando as classes acima descri-
tas. Este botao ativa o cursor que nos permite definir as areas de treino de-
senhando poligonos para cada classe. Usar como apoio para a localizagao
das areas de treino a Figura 2 (localizada no final deste ponto).

¢. Uma vez criados os poligonos, guardar esta informagao vetorial com o botao
@ (Save training samples) da barra Image Classification com o nome
AreasTreino. Este passo guarda apenas os poligonos e ndo a assinatura
espectral destas areas.

As areas de treino podem ser geridas, a medida que sao criadas, a partir do
botao E que abre a caixa Training Sample Manager.

Training Sample Manager
AR EFEx 4 U Rl Iy
Class Mame Value Color Count

Supratidal 1 195

Intertidal 3 239

Uppersubtidal 3 577
LowSubtidal 11
Raso 14
Sapal 16

Nesta caixa é possivel renomear a classe (Class Name). Juntar, numa mesma

classe, diferentes areas (poligonos) selecionando no campo ID as diferentes
classes e clicando no botéo (Merge training samples).

W Training Sample Manager
AR EEEXx ¥ Wl D

D Clase pierge training samples | Color Count

Praia Emersa 1
2| Pooimersa |3 | | 159

d. Gerar o ficheiro de assinaturas espectrais usando o botdo ¥ (Create a sig-
nature file), guardando-o numa pasta a escolha com o nome Assinaturas.
Este passo guarda um ficheiro com a extenséo .gsg.

e. Analisar a assinatura espetral de cada um dos dominios morfoloégicos através
da observacao dos graficos de dispersao disponibilizados pela ferramenta
Show Scatterplots.
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EW Training Sample Manager
I O T e A
i Class Name Value Color Count
1 Supratidal 1 199
Intertidal 3 239
Uppersubtidal 8 577

LowSubtidal 1 675
Raso 14 156

Sapal 15 43

TR

Figura 2 - Imagem de apoio a definicdo de areas de treino — posicionamento dos poliginos.

1.1.3 Classificacdo usando o método Maxima Verosimilhanca
a. Classificar aimagem usando o método de maxima verosimilhanca — Maxi-
mum Likelihood Classification — disponivel na barra Image Classification.

Classification = || [€> L8130908_Mask | EH

Interactive Supervised Classification

Maximum Likelihood Classification

lso Clus

#. ClassPr

Maximum Likelihood Classification

Perform maximurn likelihood
classification on an input image
using a signature file.

 Principa

b. Na janela do método de classificagdo assistida selecionar o ficheiro de assi-
naturas espectrais gravado anteriormente. Gravar o resultado da classifica-
¢ao como MaxLikehood. Os restantes parametros mantém-se inalterados.

c. Examinar a classificagao e verificar se esta de acordo com o que observar na
imagem. Se n&o estiver satisfeito, repitir o processo de definicdo das areas
de treino e redefinir o ficheiro Assinaturas.gsg.
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Exercicio 6.3
MAPEAMENTO DE FUNDOS MARINHQOS

Objetivos
O objetivo deste exercicio é proceder ao pds-processamento das imagens
anteriormente classificadas. O processo de filtragem é muito utilizado na

pos-classificacdo, uma vez que permite melhorar a classificacdo obtida.

A filtragem consiste na aplicacdo de filtros, isoladamente ou de forma
sucessiva, com o objetivo de generalizar determinada caracteristica ou
de eliminar o ruido.O ArcMap possui uma variedade de filtros, que podem
ser acedidos quer através da caixa de ferramentas Generalization, quer
através dos botdes |EiEiE Lalid da ferramenta Image
Analysis.

A.FILTRAGEM

1. Aplicagao de filtros para eliminagao de ruido

1.1 Aplicar filtros de generalizagéo para limpeza de uma das imagens an-

teriormente classificadas.

As imagens anteriormente classificadas, quer a imagem de backscatter quer a

imagem otica, apresentam zonas bem classificadas, mas outras zonas apresen-

tam alguns pixeis que claramente se encontram mal classificados. Aplicando
alguns filtros de generalizacao é possivel melhorar a classificacao inicial.

a. Escolher uma das imagens classificadas para realizar o processo de filtra-
gem.

b. Usando os filtros disponiveis na caixa de ferramentas Generalization
(ArcToolBox W Spatial Analyst Tools » Generalization) tentar melhorar a
classificacao.

1. Usar por exemplo o filtro Majority Filter ou Aggregate?. Se nao estiver
satisfeito experimentar outros.

2 Aajuda do ArcGis pode ser muito eficaz a explicar os conceitos por detras dos filtros. Consulte por exemplo
http://resources.arcgis.com/EN/HELP/MAIN/10.2/index.html#/Aggregate/009z00000034000000/
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Exercicio 6.4
MAPEAMENTO DE FUNDOS MARINHQOS

Objetivos

O objetivo deste exercicio é proceder a operacdo de fusdo de bandas
denominada pansharpen. Esta operacgao de fusao permite fundir bandas
com resolucdo espacial diferente. As bandas do sensor 6tico OLI do satélite
Landsat 8 apresentam, todas, informacao espacial a 30m, com excecdo da

banda pancromatica, B8, que apresenta um pixel com 15m.

Através da operacdo pansharpen é possivel fazer uma interpolacdo da ban-
da pancromatica, e manter, nas bandas multiespectrais, a resolucao de 15 m
da banda pancromatica.

A.FUSAQ DE BANDAS

1. Fusao de bandas com diferente resolug¢ao espacial

1.1 Operacao de Pansharpen com o método Gram-Shmidt

a.

=

Adicionar ao georreferencial as imagens 18130908c2, 18130908c3,
18130908c4, que correspondem respetivamente as bandas 2, 3 e 4 (Blue,
Green e Red) da imagem Landsat 8.

Fazer uma composigao colorida destas bandas em cor verdadeira.

Adicionar a imagem 18130908cPan, que corresponde a banda pancromatica
do mesmo sensor.

Na janela Image Analysis, selecionar a imagem compdsita e a imagem pan-
cromatica selecionadas.

No botéo 2|, escolher o método Gram-Schmidt no separador Pan Sharpen e
certificar-se que o sensor selecionado é o Landsat 8. Clicar Ok.

Clicar no botdo & (Pan Sharpen).

Verificar e registar a resolugao espacial da nova imagem.

Usando a imagem classificada da zona de Troia e esta nova imagem, avaliar
novamente a classificagao realizada. Que conclusdes tira?
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B. SISTEMATIZACAQ DE CONHECIMENTOS

1. Qual a diferenca entre classificacao assistida e classificagdo automatica?

2. Indicar um método de classificagdo usado no tipo de classificagédo assistida e
classificacdo automatica.

3. As operacgdes de filtragem sao normalmente utilizadas em que etapa do pro-
cessamento?

4. Afiltragem pertence a que tipo de processamento de imagem?
5. Em que consiste a fusao de bandas?
Referéncias:
IH (2015) — Para mais informagdes sobre os equipamentos disponiveis no Institu-

to Hidrografico consultar e.g.
http://www.hidrografico.pt/sondadores-multifeixe.php.
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Exercicio 7
MAPEAMENTO DE MANCHAS

DE OLEO - IMAGENS SAR

Objetivos
O objetivo deste exercicio é proceder ao mapeamento de manchas de 6leo

e de embarcacdes usando imagens SAR (imagens geradas por sistemas radar
de abertura sintética).

As imagens SAR séo ideais na detecao de manchas de petréleo, uma vez que estas
manchas (oil slick) aparecem como zonas escuras nas imagens. Do ponto de vista
operacional, a detecédo destas manchas é realizada em dois passos distintos: 1) detecdo
de slicks e 2) classificagao para determinar a natureza do slick — natural (biolégico) ou
artificial (manchas de 6leo).

As imagens SAR também sdo muito utilizadas na dete¢cao de embarcagdes, uma vez
que estas apresentam um retorno muito grande do sinal na zona onde as embarcagodes
estao presentes.

AJNTRODUQAO
BERE NEWS woswo eorrion

You are in: Europe

Mews Front Page Tuesday, 19 November, 2002, 14:34 GMT WATCH/LISTEN  FreAL MEDIA
o 1 H H ON THIS STORY
¥ 4@y Stricken oil tanker sinks  [J e
T i "The destruction of the
1 i} d marine environment has
. R begun”
Af_rlca ' The BBC's Stephen Sadar
Americas "This beautiful coastline is
Asia-Pacific in grave danger”
' Spanish Deputy Pime
Middle East Minister Mariano Rajoy

"There is no further
breach of the tanks"

W Sehastian Losada, Greenpeace
"They have been painting
the coast because they
were moving the vessel"

South Asia
UK

Business
Entertainment
Sdence, Nature
Technology il has been washing up en beaches in Gal

Health » ctricken tanker which has been leaking oil
off the north-west coast of Spain has begun to

Tallinm Daind

http://news.bbc.co.uk/2/hi/europe/2487739.stm
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Uso de imagens de satélite em situagao de emergéncia

A 13 de Novembro de 2002 o petroleiro Prestige, que transportava 77 mil toneladas de
petréleo, sofreu uma rutura num dos seus tanques, durante uma tempestade ao largo

da costa da Galiza. As 8:00 da manha de 19 de Novembro, o navio partiu-se ao meio,

afundando-se durante a tarde e libertando o petréleo para o mar.

O incidente do Prestige poluiu centenas de quilémetros de linha de costa e mais de uma
centena de praias nas costas de Espanha, Franca e Portugal, tendo sido considerado o
maior desastre ambiental na histéria de Portugal e Espanha.

No sentido de apoiar as agéncias responsaveis pela resposta ao incidente do derrame
de petréleo, a Agéncia Espacial Europeia (ESA) forneceu dados espaciais dos satélites

ERS e Envisat, quase diariamente desde 17 de Novembro.

Algumas destas imagens, utilizadas no esforco de mapeamento e mitigacdo do derrame
estdo disponibilizadas no site da ESA e podem ser descarregadas de forma gratuita.

B. CARTOGRAFIA DE EMERGENCIA - IMAGENS SAR

1. Descarregar a imagem SAR na altura do derrame

1.1 Descarregar a imagem SAR do sensor ASAR a bordo do satélite Envisat
a. Navegar até: https://earth.esa.int/web/guest/data-access/sample-da-

ta/-/asset_publisher/tg8V/content/prestige-oil-spill-galicia-spain-
16237?p_r_p_564233524_assetldentifie#_56_INSTANCE_z3vD_matmp

b. Em Available Sample Data escolher ASAR.

c. Descarregar a imagem ASAR Wide Swath (WS) ASA_WSM_1PXP-
DE20021117_104431_000000672011_00180_03741_0009.N1.gz, que cor-
responde ao dia 17-11-2002.

d. Descomprimir para uma pasta com o mesmo nome e adicionar a imagem
ASAR ao georreferencial do ArcMap.

e. \Verificar a resolucao espacial da imagem e comparar com a resolugao espa-

cial da Tabela 1.
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2. Mapear a extensao do derrame

O mapeamento de manchas de 6leo na agua, numa imagem SAR, é facilitado pelo facto
destas manchas se apresentarem em tons mais escuros relativamente aos restantes
elementos da imagem. Isto acontece porque a zona com 6leo apresenta muito pouca
rugosidade, o que por sua vez influencia o retorno do sinal para o sensor SAR, nao
havendo quase nenhum retorno de sinal nesta circunstancia (valores escuros). Fazen-
do uso desta caracteristica ir-se-a mapear a area de derrame de petroleo no dia 17 de
novembro de 2002.

2.1 Reducao do ruido tipico das imagens SAR
O ruido “sal e pimenta” ou speckle noise € um tipo de ruido de alta frequéncia
presente nas imagens de radar. As imagens geradas por sistemas radar de
abertura sintética (SAR) sédo altamente sujeitas a estes efeitos de ruido devido
ao processamento de sinais dispersos e interferéncia de ondas eletromagnéticas
dispersas pelas superficies ou objetos.
Existem diversos algoritmos que permitem filtrar os dados de radar suavizando o
ruido e mantendo os contornos dos objetos. A ferramenta de analise de imagem
(Image Analysis) apresenta, na funcao Speckle Function, alguns desses algorit-
mos, permitindo filtrar as imagens SAR.
a. Sobre aimagem SAR descarregada e com a fungao Speckle Function da
ferramenta Image Analysis filtrar a imagem. Alternar entre diferentes tipos
e tamanhos de filtros, escolhendo, por fim, aquele que melhor se ajusta ao
objetivo do exercicio.
b. Anotar o tipo de filtro e o tamanho para futura referéncia.

2.2 Delimitacdo automatica do derrame

A delimitagdo automatica do derrame pode ser realizada, de forma simples, a

partir da definigdo de um valor de limiar (threshold) correspondente ao maximo

valor de pixel considerado como pertencente a mancha de 6leo e acima do qual
se considera que nao ha presenga de petréleo. A imagem € entao classificada
em dois valores: 1 — 6leo e 0 ou Nodata — nao oleo.

a. Definicdo de um valor de threshold adequado a presenca de 6leo da agua.
Usar a ferramenta Interactive Threshold j4 para encontrar um valor de
limiar adequado.

b. Uma vez definido o valor de threshold proceder a classificacdo da imagem
usando a ferramenta Reclassify do 3D Analyst (no ArcToolbox). Usar duas
classes e novos valores de 1 — 6leo e 0 — nao dleo. Ativar a opgdo Change
missing values to Nodata. Ter em atenc&o que valores de 0 na imagem
SAR correspondem a NoData.
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¢. Limpar aimagem usando um filtro apropriado disponivel na caixa de ferra-
mentas Spatial Analyst Tools » Generalization.

d. Reclassificar a imagem filtrada de forma a obter os valores do éleo represen-
tados a 1 e os restantes como NoData.

e. Salvar a imagem raster final com o nome Mancha.

2.3 Calcular a area afetada pelo derrame

a. Converter a imagem em formato raster para poligonos: Raster to Polygon
(Conversion tools do ArcToolbox).

b. Limpar eventuais poligonos que o processo de filtragem nao tenha consegui-
do resolver: Start Editing » editar > Stop Editting. Podera também eliminar
os poligonos mais pequenos através da utilizagdo de um filtro (Query).

Uma vez que a nossa camada vetorial se encontra com o sistema de coordena-
das geograficas, tera que proceder a sua projecao para um sistema de coordena-
das retangulares, para efetuar o calculo das areas.

c. Altere o sistema de coordenadas do georreferencial para ETRS89 — PTMOG.
Crie um campo, na tabela de atributos, denomidado Area: Attribute Table »
Add Field. Use o tipo Double.

e. Sobre a coluna Area: BDLR D> Calculate Geometry » Area. Calcule a area
em km2,

f. A soma de todos os poligonos individuais permite ter uma ideia da area total
afetada: Sobre a coluna Area » BLDR P> Statistics. Qual a area total afetada?

2.4 Detecao de embarcagdes
E possivel detetar a presenca de embarcagdes nas imagens SAR, de forma mui-
to simples, uma vez que estas apresentam um retorno muito forte do sinal (va-
lores brancos) devido a reflexdo especular dupla. Desta forma, e a semelhanca
do que foi feito para detetar a mancha de 6leo, definir-se-a um valor de threshold
para a identificacdo das embarcacodes, sabendo que neste caso o retorno € mais
forte (tons brancos).
a. Definicao de um valor de threshold adequado a presencga dos navios. Use a
ferramenta Interactive Threshold M para definir um valor limiar adequado.
b. Mascare as zonas de terra usando a funcao Clip Function — acedida com o
botdo 4 sobre o raster BDLR P Insert » Clip Function.
1. Use como Type a opcéao Inside, uma vez que se pretende remover a
area dentro do poligono de mascara.
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2. Como Clipping geometry use a camada Mask_Terra_SAR (disponivel
na pasta do exercicio 7).
3. Selecione a opgao Use Input Features for Clipping Geometry, para
que a mascara utilize os contornos do poligono.
c. Uma vez definido o valor de threshold proceder a classificagdo da ima-
gem usando a ferramenta Reclassify do 3D Analyst (no ArcToolbox). Use
duas classes e novos valores de 1 — navio e 0 — nao navio. Active a opgao
Change missing values to Nodata. Tenha em atengao que valores de 0 na
imagem SAR correspondem a NoData.
d. Limpar aimagem usando um filtro apropriado se achar necessario.
e. Reclassificar a imagem filtrada de forma a obter as embarcagbes representa-
das a 1 e os restantes como NoData.
Salvar a imagem raster final com o nome Navios.
g. Transformar a imagem de formato raster para formato vetorial - poligonos.
Use a ferramenta Raster to Polygon (Conversion tools do ArcToolbox).

2.5 Producao de cartografia e disponibilizagao a terceiros

A producao de mapas tematicos é um dos objetivos da cartografia de emer-

géncia. A sua disponibilizagao a terceiros pode efetuar-se, ndo s6 em formato

raster ou vetorial mas, também em formato PDF. Desta forma, proceder-se-a a

producdo de um mapa com a area afetada pelo derrame e disponibilizar-se-a em

formato PDF com informagao geografica associada.

a. Representar a mancha de petréleo identificada na imagem SAR através de
um mapa semelhante ao da Figura 1.

b. Exportar o mapa em formato PDF: File » Export Map. Escolha o tipo de
ficheiro PDF e assegure-se que a op¢cao Export Map Georeference Infor-
mation se encontra selecionada (em Options, separador Advanced).

2.6 Visualizacao da informagéao geografica incluida nos ficheiros PDF

Os documentos PDF podem conter uma grande quantidade de informacgéao extra,

nomeadamente podem incluir atributos com informacao de natureza geogréfica.

a. Abrir o ficheiro PDF anteriormente criado no Adobe Acrobat Reader DC.

b. O ficheiro gravado neste formato permite, por exemplo, ver as camadas usa-
das no nosso mapa através do botdo *- . Verificar as camadas presentes no
mapa colocando cada uma deles visivel/invisivel (botdo [m).

c. No separador Tools clicar em Measure’.

"Em versdes Adobe Acrobate Reader mais antigas, estas ferramentas estao disponiveis em: Edit ™ Analysis Tools e
permita que as opgdes Object Data Tool e Geospatial Location Tool estejam ativas. No Adobe Acrobat Pro estao dis-
poniveis em: Tools » Analysis; existindo uma ferramenta adicional que permite efetuar medigbes sobre o mapa.
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d.

De seguida clicar na ferramenta Geospatial Location Tool. A ferramenta
vai exibir as coordenadas em latitude e longitude, a medida que o cursor se
move sobre 0 mapa.

Clicar na ferramenta de medicao (Measurement Tool). Esta ferramenta per-
mite tragar um segmento e calcular a distancia? (em km) entre dois pontos.

Imagine que faz parte de uma entidade que tera de programar voos de monitori-

zacgao da mancha de o6leo:

1. Escolher um local na costa e calcular a distancia até a zona afetada
mais longinqua. Estimar a autonomia minima (em distancia) que um apa-
relho deve ter para fazer o reconhecimento da mancha?

Mancha de petréleo

Service Layer Credits: Source: Esri,
DigitalGlobe, GeoEye, i-cubed, USDA, USGS,
AEX, Getmapping, Aerognd, IGN, IGP,
swisstopo, and the GIS User Community

Figura 1 - Mapa tematico da localizagéo do derrame de petréleo ao largo da costa da Galiza.

2 Para alterar as unidades de medigéo podera carregar com o BLDR sobre o PDF e em Preferéncias configurar as diferen-

tes unidades.
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FRODUCT 1D

ASA WSM 1P

NAME ASAR wide swath standard image
DESCRIPTION ASAR product generated from Level 0 data collected when the
instrument 15 in wide swath mode.
The product includes slant range to ground range coffections per
definition.
The product covers a conlinuous area along the imaging swath.
COVERAGE

400 km * 400 km{approximately) for a scene;, 400 km * 4000 km
max for a siripe

GEOMETRIC RESOLUTION

approximately 150 m * 150 m

RADIOMETRIC RESOLUTION

Product ENL > 11.5

PIXEL SPACING

Tim™*75m

S1ZE

59 Mbwytes for a scene
584 Mbyies for a siripe

DATASET

each product scene containing the following:
(1) header MPH + SPH

(2) 3400 data records

(3) 3450 samples/frecord

{4) 2 bvtes/sample

AUXILIARY DATA

Orbit state vector . Time correlation parameters. Main Processing
parameters ADS, Doppler Centroid ADS, Chirp ADS, Antenna

Elevation Pattern ADS, SR/GR ADS, Geolocation Grid ADS, S0
ADE

INTERNAL CALIBRATION

For the purpose of calibration
1. Drata 1A0) correction
2. Replica construction
3. Calibration pulse processing
4. Elevation gain function calculation
5. Noise power estimation

Tabela 1 - Caracteristicas da imagem ASAR_WSM_1P. Retirado de:
http://envisat.esa.int/services/sample_products/asar/asar_sample_prducts.pdf
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Exercicio 8
DADOS MULTIDIMENSIONAIS

Objetivos
O objetivo deste exercicio é representar dados de natureza multidimensional em

formato NetCDF em ArcMap. Neste exercicio pretende-se representar a variacdo
espacial da temperatura superficial no Atlantico Norte entre 1979 e 2013.

A.INTRODUCAO - FORMATO NETCDF

NetCDF (Network Common Data Form) € um formato de arquivo projetado para supor-
tar a criagao, acesso e partilha de dados cientificos, muito utilizado pelos geocientistas,
especialmente nas comunidades que gerem dados atmosféricos e oceanograficos para
armazenar variaveis (temperatura, pressao, velocidade do vento, altura de onda, etc.).

O ArcGIS pode ler um ficheiro NetCDF em trés formatos diferentes: raster, feature ou
tabela, de forma nativa, i.e., sem necessidade de conversio dos dados. No entanto, os
ficheiros NetCDF n&o sao adicionados ao georreferencial através do botdo Add Data +

sendo, em vez disso, necessario utilizar as ferramentas disponiveis na caixa de ferra-
mentas Multidimension Tools, ou em alternativa arrastar um ficheiro NetCDF do Win-
dows Explorer diretamente para a aplicagéo.

B. AQUISICAO DE DADOS

O portal “COPERNICUS MARINE ENVIRONMENT MONITORING SERVICE -
http://marine.copernicus.eu/ constituiu um importante repositério de dados oceanografi-
Cos a nivel europeu.
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“Marine data is an engine for “smart and sustainable growth” in the European Union, as
stated in the recent Marine Knowledge 2020 EC Communication. The Copernicus Marine
Service has been designed to respond to issues emerging in the environmental, busi-
ness and scientific sectors. Using information from both satellite and in situ observations,
it provides state-of-the-art analyses and forecasts daily, which offer an unprecedented
capability to observe, understand and anticipate marine environment events.”

1. Descarregar a informagao da temperatura superficial do oceano do Portal
Copernicus

a. Navegar até ao endereco (http://marine.copernicus.eu/)

b. No catalogo online (botdo Online Catalogue) pesquisar dados para o ocea-
no global que incluam uma série temporal superior a 20 anos.

c. Do conjunto de dados disponiveis escolher os referentes ao “GLOBAL
OCEAN PHYSICS REANALYSIS ECMWF ORAP5.0 (1979-2013)".

Estes dados correspondem a uma reanalise do oceano global produzida pelo
European Centre for Medium-Range Weather Forecasts (ECMWF) como
uma contribuicao ao projeto MyOcean2. O Produto ORAP5.0 cobre o peri-
odo de1-jan-79 a 31-dez-2013 e foi produzido com a versao 4.3 do modelo
NEMO com uma resolugao horizontal de 0.25° e 75 niveis na vertical.

d. Selecionar o carrinho de compras (ADD TO CART) e, em seguida, escolher
a opgéo download.

e. Em Dataset escolher a opcao “GLOBAL-REANALYSIS-PHYS-001-017-RAN-
UK-ORAPS5.0-SST”

f. Na area geografica escolher a opcado North Atlantic e em Start Date sele-
cionar 16-01-1979; deixar as outras opg¢des nos valores pré-definidos.

g. Fazer o download da imagem (canto superior direito).
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C. REPRESENTACAQ DOS DADOS EM ARCMAP

2. Abrir o ficheiro descarregado no ArcMap arrastando-o para a area do
mapa

a. Nas propriedades do tema, separador NetCDF, escolher a variavel que lhe
parecer mais adequada.

b. Alterar o esquema de cores para uma gradagao mais percetivel (Figura 1).

Figura 1 - Exemplo de representagao da temperatura do oceano superficial a partir de um ficheiro NetCDF.

D. REPRESENTACAO DA VARIACAO TEMPORAL

3. Ativar as funcionalidades de tempo disponiveis para camadas de dados
com atributos temporais

a. No separador Time, da caixa de propriedades da camada, ativar o campo
Enable time on this layer.

b. Preencher os diferentes campos referentes a Time Properties e fazer Apli-
car.

4. No menu de ferramentas do seu projeto, ative a ferramenta de visual-
izagado de dados temporais Time Slider, carregando no icon =
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a. Observar a variagao espacio-temporal dos dados explorando as diferentes
opgdes de Time Slider.

b. Explorar as opgdes de visualizagado carregando no botdo Options do Time
Slider, para p.ex. ver as variagdes de temperatura com uma frequéncia men-
sal e com a apresentagdo da data no seu referencial.

5. Exportar a variagao espacio-temporal para video (opcional):
a. Alterar a visualizagao para uma menor frequéncia de visualizagéo e gravar

um video com a variacao espacio-temporal da temperatura do oceano a su-
perficie carregando no botdo Export to video L. .
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